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Main Menu > Import Data

Selecting the ‘Import Data” Option enables the user to UPLOAD and EDIT files into
the system. A wizard is available with the following two options:

| h;a_,! Import Data = o
- Data Import Wizard - Step 1
U Import data based on an existing template 9
U (& Import data based on an existing template

7
\

This menu enables you to
upload data files into the
systern. Tour data can
autornatically be uploaded
easily and correctly

To upload data based on an existing termplate you need to select the subject/project from the above list and
click on the option "Upload data”
Ta review or modify the template of the projact click on the option "Edit ternplate”

Create a new template for your input data

()  Create a new template based on an (&) Create a new template defining all the
existing excel file relevant fields fron the beginning
(1]
Select this option if you have already created the Select this option in case you have not created the
relevant Excel file including the data you want to relevant Excel file

publish (It Is lass time consuming since the tsmplats
is autamatically created by the system enabling you
to perfectly adapt it to your needs)

(3

You Map: Import Data P

No | Area

Description

o General
Help Text

On the left hand side of the Import Data window, the user may find a helpful
text regarding the section.

- CLOSE > The ‘Close’ button is always on the bottom left hand side of the page

and allows the user to close the window and return to the Main page.

9 Data
Import

Wizard

The Data Import Wizard enables the user with the following actions to his
Projects:

1. Import data based on an existing template

This Option allows the user to Upload or Edit data based on an existing
template.

2. Create a new Template for your Input Data

- Create a new Template based on an existing excel file > This Option
allows the user to create a new template from an existing file.




No | Area

Description

- Create a new Template defining all the relevant fields from the
beginning > This Option allows the user to create a new Project from
scratch.

CLOSE

3

CLOSE > There is a ‘Close” button on the bottom left hand side of the page allows

the user to close the window and return to the Main Page.

1.1. Import Data > Existing Template

1. Import data based on an existing template

When the ‘Import data based on an existing template’ option is selected, A drop-
down list with all Projects available, The “Upload” Button, ‘Edit Template” and
‘History/Data Management’ Buttons appear.

Q Import Data =1 =]

Data Import Wizard - Step 1

Import data based on an existing template

G Import data based on an existing template
exireme sports ¥
This menu enables you to

upload data files into the ELLECREEIN Edit template N History/Data management

system. Your data can

automnatically be uploaded

" To upload data based on an existing template you need to select the subject/project fram the above list and
click on the aption "Upload data”
To review or modify the template of the project click an the option "Edit termplate”

C

(
A\

Create a nevs template for your input data

(O Create a new template hased on an O Create a new template defining all the
existing excel file relevant fields fron the beginning

Select this option if you have already created the Select this option in case you have not created the

relevant Excel file including the data you want to relevant Excel file

publish (It is less time consuming since the template
is automatically created by the system enabling you
to perfectly adapt it to your needs)

You Map: Import Data

‘Upload Data’ :-To upload data based on an existing template you need to select
the subject/ project from the above list and “click” on the option "Upload data"
-'Edit template”: To review or modify the template of the project ‘click’ on the
option ‘Edit template’.

When the ‘Import data based on an existing template” option is selected, the screen
appear as follows:



@ Import Data =1 =
Data Import Wizard - Step 1

Import data based on an existing template

@  Import data based on an existing template

extreme sports ¥
This menu enables you to S =
aload: Hata flas ko tha PEILECR-EIEYN Edit template M History/Data management

system. Your data can
automatically be uploaded
easily and correctly

(
\

To upload data based on an existing template you need to select the subject/project from the abave list and
click on the option “Upload data"
To review or modify the template of the project click on the option "Edit template”

The “Upload data’ Button, ‘Edit Template” and ‘History/Data Management’ Buttons
appear and a drop down list with all Projects available for editing.

1. Upload data

When the ‘Import data based on an existing template’ is selected, a drop down list
appears; with projects available and the upload button is activated,

(& Import data based on an existing template

extreme sports v
Upload dateo Edit template M History/Data managerent

The user may click on the option button: Upload data

- Upload data - Data Import Wizard >

This menu enables the user to upload data files into the system:

Data Import Wizard

Define the data entry criteria and browse the relevant file according to the project: extreme sports

Types of files accepted: Excel files(xls,xlsx), and text files (.csv)
 Only data included in the first sheet of the file can be entered into the system.

e Textfiles {.csv) are required to be saved in a utf-8 coding format and a comma have to be used as
indicator for different columns.

Data entry criteria.

Does your file have headings? | Yes v

Do you want to delete the existing data? No «

‘ Avalhtnan... | Aev emifiéxBnke apxeio.

The user can define the data entry criteria according of the project that is already
selected and written in red in this screen. In this example the project is ‘extreme
sports’.
The user defines with yes/no the data formatting of his/her file, by the following
options:

- Does your file have headings?

- Do you want to delete the existing data



Along with, browsing his/her Excel (.xls/.xlsx) or .csv file.

Data entry criteria.

Does your file have headings? ’ Yes ¥

Do you want to delete the existing data? [ No v

‘ Avalitnan... | Aev emifiéxnke apxeio.

@ Tip: The types of file formats are Excel files (.xIs, .xIsx) and Text files (.csv)

Only data included in the first sheet of the file can be entered into the system.
Text files (.csv) are required to be saved in a utf-8 coding format and a comma

have to be used as indicator for different columns.

2. Edit Template - Data Import Wizard >

This menu enables the user to Edit the Template of the selected Project:

When the ‘Import data based on an existing template” is selected a drop down list
with projects is available. Such as the ‘extreme sports” project as follows.

(& Import data based on an existing template

extreme sports v
Upload data) Edit template M History/Data management

Data Import Wizard - Data Import Wizard >

A Project consists of a Template (that may be created or modified).

The user creates the Template, he/she imports the data, then formats the View and
check the Preview before publishing his/her Project at the YouMap® or at his/her
own Web Site.

Template is a Table of data with column headings and data; whereas data may be
numerical; dates; etc.

Each Template is defined by its data and data types.

This menu enables the user to edit the template of Project.
The following screen is divided into a Form and a Table.

Form



@ Import Data =0 =8 =<
Data Import Wizard

Edit template

&v/} The following tables enable you to modify the template of the uploaded data file. Here the X (latitude) and ¥

{longitude) columns as well as the primary key (up to two fields) need to be defined to ensure the
uniqueness of the data.
This menu enables you to | Data will not be entered unless you define the X & Y columns,
upload data files into the
systern. Your data can

automatically be uploaded | | poioct name [eemespome
easily and correctly
Description sports in greece ‘
Project logo =
&) hikingkonitsa *® v

Upload data

Table

Total number of columns: 23
[colnumber|Titie [special column [Data Type e
1 [Kamnyopia [ ~ [ General ~  OpsiBacia
2 [Mepoxa [ v~ [ General ~  'Ohupnog
3 [ Nopée [ ~ [ General ~ Migpia-Adapioa
4 [ apBuse Sadpopdy [ ~ | Number v
s ']mﬁlpog SuakoAiae [ v '\ General ~
6 [Mrixoc Aadpomre [ ~ | General ~
7 [ Kanirepn enoxr [ ~ [ General ~
s [ karérAnho yia naudia [ v [ General ~
=] [xapaxtipae nediou [ v [ General ~
10 [ npocavatoranse [ ~ [ General -
11 [ ermeraearirms [ & [ Gorieral ~
12 [x [Latitude & [ General v 40.0827777
13 v [ Longitude '~ [ General v 22.3511111
14 [ £ovoro Marav [ ~ | Number -
15 ']A\dpkalrx KewéBaonc [ v '\ General ~
16 | BeBporovia Aadpopric [ v [ General v
17 | Adprewa Aadpopnic [ ~ ‘\ General ~
18 [ Edvore AvaBatApmy [ v~ [ General ~
19 [ovawvérepn néAn [ v '\ General ~
20 [ Zuvors Mrkoe Maray [ ~ [ General v
You Map: Import Data

FORM >
All the above fields are editable.

- Project Name > An editable Free Text field where the user enters the name
of the Project

- Description > An editable Free Text field with a short Description of the
Project.

- Project Logo > The user can upload any (.jpeg/.png/.bmp) image as Logo of

No file(s) uploaded

—
g e ks ‘\
the Project ===

-

or delete it, by clicking

TABLE >



This Table enables the user to edit the names of the column headings (titles) and the

data type of each column.

Total Number of Columns > The YouMap® identifies the Total Number of
Columns of the Project, whereas in this case the number of Columns is 23.

Total number of columns:23

Col.Number: An autoNumber that counts the number of Columns.
Title: The headings of the Project Template are available for editing.

Special Column: This Column allows the user to define criteria for the type of
data of the corresponding/related column. The available data types are: a.
primary key b. latitude c. longitude.

Data Type: This Column allows the user to define criteria for the type of data
of the corresponding/related column. The available data types are: a.
General b. Number c. Date/Time d. Hyperlink e. Image (from file) f. Image
(e.g flicker, other image banks) g. Image (URL) h. YouTube Video i. file.

Sample: A random sample record appears from the Project for better
visibility.

SAVE > The ‘Save’ button is always at the right bottom of the page:

Once the user clicks the ‘Save’ Button either

A successful message appears:

Data saved successfully, Reloading Project...

An Unsuccessful message appears:

In case of an error found in validation, means that the data type criteria that are set

into the template, don’t match with the data type of the data of the Project.

The Following message appears and the user may open the project through Excel

and make the appropriate changes by clicking the ‘here’ link as follows.

The attention Message appears:

Project contains data that cannot be parsed to the type that was defined for the specific field,
2 You may download an excel file to check data type errors by clicking here, Cells with data type errars are highlighted with red color.

The user can open/save the Project by clicking ‘here’ and make any appropriate

changes into the data types, if necessary.



The fallowing tables enable you to modify the template of the uploaded data file. Here[R AT ETR IR P I @ e
to ensure the unigueness of the data
Data will not be entered unless you define the X & Y columns.

EnhéZare va avolgere:
[] extreme sports.xls

nou givar: Microsoft Office Excel 97-2003 Worksheet (256 KB)
[extreme sports ané: http://192.168.8.6

Project name

Description

Tiva kave o Firefox pe ouTh To apyeio;
sports in greece

© ‘ayowpape | Microsoft Office Excel (nposmhoyt) v

(' AnoBrikeuan apxelou
[ Mayi

anb ebi kai népa yia Tou giboug.
Project logn

] extreme_sports.

YE |

Project contains data that cannot be parsed to the type that was defined for the specific field.

‘You may download an excel file to check data type errors by clicking here. Cells with data type errors are highlighted with red color.

Upload data)

Total number of columns:23

Col Number | Title Special Column | Data Type

Sample
1 [ Kamnyopia ~ | Number v  Opsfacia
2 [ Mepuoxi v [General v~ Olupnog

The Buttons at the bottom of the Page perform the actions as described below:

SAVE > When the user “clicks” the ‘Save’ button

DELETE PROJECT > When the user “clicks’ the ‘Delete Project” button

Delete project
he/she deletes the whole project. Eg. ‘extreme sports” Project

DELETE DATA > When the user ‘clicks’ the ‘Delete Data’ Button

Delete data

empty

He/she deletes the data but the data template remains

BACK> When the user “clicks’ the “Back” button, he/she returns to Previous

Back
If the user hasn’t saved his changes, he/she exits the page;
this action equals ‘Cancel’.

Menu.

3. History Data Management >

This menu enables the user to manage his/her Projects. He/she is enabled to review

and edit at some level the current or older versions of Projects. For more Details,
check “‘Manage Your Data” Option on the Main Page.

1.2. Import Data > New Project >Existing file

2. Create new template based on an existing excel file

In this case the user selects the option bellow.



Import Data =2 =3

Data Import Wizard - Step 1

Import data based on an existing template

() Import data based on an existing template

«

This menu enables you to
upload data files into the
system. Your data can
automatically be uploaded
easily and correctly

To upload data based on an existing template you need to select the subject/project from the above list and
click on the option "Upload data”
To review or modify the template of the project click on the option "Edit template”

Create a new template for your input data

(@ Create a new template based on an () Create a new template defining all the
existing excel file relevant fields fron the beginning
Next
Select this option if you have already created the  Select this option in case you have not created the

relevant Excel file including the data you wart to relevant Excel file
publish (It is less time consuming since the template

is automatically created by the system enabling you

to perfectly adapt it to your needs)

Close

You Map: Import Data

Create new template based on an existing excel file. The user “clicks” the Next Button
and the following form opens:

Create a new template for your input data

(%) Create a new template based on an
existing excel file

Select this option if vou have already created the
relevant Excel file including the data you want to
publish (It is less time consuming since the template
is autormatically created by the systemn enabling you
to perfectly adapt it to your needs)

The user selects this option if he/she has the relevant Excel (.xls / .xlsx) file or
Comma-separated value (.csv) file including the data he/she wants to publish.

The user clicks the button and the following form opens.

Data Import Wizard - Step 2 A

Create a new project based on an egisting file

Project Name

Description



http://en.wikipedia.org/wiki/Comma-separated_values

The following Free Text fields appear:

- Project Name > The Name of the Project (The Project Name is a mandatory
field and needs to be more than 4 characters long).

- Description > A short Description of the Project

> If the user does not fill in the free text fields properly, the following message
appears: ‘Please check your input and try again” as follows:

Please check your input and try again.

> The user enters the Project Name and Description properly.

Create a new project based on an existing file

Project Name extreme spors

Description Gengraphic representation of 'extreme sparts' locations. |

The user ‘clicks” the Next Button to continue in order to proceed to the next
step where he is enabled to upload the relevant Excel (.xls /.xlsx) file or Comma-

separated value (.csv) file:

Data Import Wizard - Step 2 B
Create a new project based on an existing file
Name of the new project: extreme sports

You need to select a file document in order to analyze and save the template. It is not necessary to include
many entries, even a small sample of five entries for example, would be sufficient.

Types of files accepted: Excel files(xls,xlsx), and text files (.csv)

e Only data inclu he first 5 rows of the first sheet of the file can be entered into the system.
*  Textfiles quired to be saved in a utf-8 coding format and a comma have to be used as
indicator ent columns. Only the first 5 rows will be processed

l AvalhTnon.. | Aev emigxBnke apxeio.



http://en.wikipedia.org/wiki/Comma-separated_values
http://en.wikipedia.org/wiki/Comma-separated_values

The screen presents the name of the new project that is declared from the previous
step, in red. The user can now upload the Excel (.xls / .xlsx) file or Comma-separated
value (.csv) file by clicking the “Search’ Button.

Data Import Wizard - Step 2 B

DopTeon apxeiou

Look in: ‘6 emanouela "| v ? 2 '
Man -
“au L\é ary to include
My Recent 4
O] Documents
H ?’"—'%
LT L
Desktop
. e system.
. ‘_J be used as
Iy Documents
E by Computer

Q File name: |Uulduur sporte.xls s | [ Open ]
My Netwark Files: of type: |'Dﬂc: Tot preion w | [ Cancel ]

The screen becomes as shown above and the user searches the file he wants to upload,
he/she selects the file and ‘clicks” “Open’.

Data Import Wizard - Step 2 B
Create a new project based on an existing file
Name of the new project: extreme sports

You need to select a file document in order to analyze and save the template, It is not necessary to include
many entries, even a small sample of five entries for example, would be sufficient.

Types of files accepted: Excel files(xls,xlsx), and text files (.csv)

o Only data included in the first 5 rows of the first sheet of the file can be entered into the system,

o Textfiles {.csv) are required to be saved in a utf-8 coding format and a comma have to be used as
indicator for different columns. Only the first 5 rows will be processed

Uploading file [outdoor sports.xls]... Completed.
100%

When the Excel (.xls / .xlsx) file or Comma-separated value (.csv) file is

successfully uploaded the user proceeds in step 3.

Data Import Wizard - Step 3

Create a new project based on an existing file

Name of the new project: extreme sports

File outdoor sports.xls was succesfully uploaded. In order to analyze the template of the file select the

"Analyze"button. Analysis will be completed based on the first rows of the file

Uploaded file has headers? Yes v



http://en.wikipedia.org/wiki/Comma-separated_values
http://en.wikipedia.org/wiki/Comma-separated_values
http://en.wikipedia.org/wiki/Comma-separated_values

Uploaded file has headers? Yes ¥

At this step, the user is asked whether the uploaded file has or doesn’t have any

headers by yes/no drop-down and then clicks the Analyze Button

The following screen opens:

@ Import Data

Data Import Wizard - Step 3

Q Create a new project based on an existing file

M Name of the new project: extreme sports

This menu enables you to File analysis completed successfully. To verify or modify the format of the columns click
upload data files into the
system. Your data can | ¥ (langitude) and Y(Latitude) columns has been successfully placed.

au“_’mat'ca”" Seyiploadad Latitude column:12 , Longitude column:13.
easily and correctly

The columns found are shown in the following table:

1 - Category

2 - Region

3 - County

4 - Number of Routes

5 - Range of Difficulty

6 - Length of Route

7 - Better Season

8 - Suitable for children
9 - Type of Activity

10 - Orientation

11 - Access Time

14 - Total of ski pistes
15 - Duration of descent
16 - Route Rating

17 - Route Length

18 - Total Lifts

19 - Nearest City

20 - Total Length of Pistes MioTwv
21 - Type of Destination

YouMap® identifies the following data:
- The Name of the Project : extreme sports (in red color)
- X (Longitude) : The Number of records with X (12)
- Y (Latitude): The Number of records with Y (12)

- The Column Headings

Clicking the “Here” Button enables the user to make ad-hoc modifications to

the file, if necessary.




Data Import Wizard - Step 4
Edit template

The following tables enable you to modify the template of the uploaded data file. Here the X (latitude) and Y (longitude) columns as well as the primary key (up to two fields) need to be defined to ensure the
uniqueness of the data.
Data will not be entered unless you define the X &Y columns.

Project name extreme sports
Description
Project | P
(QIRER00 Mo file(s) uploaded \[Upload
[(avagimnon.. | v endecine aoxcio | Logo
——

Upload data)

Total number of columns:23

|col.number | Title Special Column | Data Type Sample

1 [Category v [ Geneal v  Oreibasia

2 [Region 1 v [ Genesal 3 Olympos

3 | County ] v '! General @ picria-Larica

4 [Number of Routes [ [ General v

s [Range of Difficulty [ ¥ [Geredl

6 [Length of Route [ v ‘[ General =

7 [Bekter Season T & | Genera =)

B [Suitable for childien [ v | General v

9 h\ Type of Activity '\ v A[ General v

10 [ Drientation [ v [Geneal =l

11 [Access Time [ v ,’ General =il

12 53 [Latude v | Genera v 400827777

13 [¥ [Longtude v [ General ¥ 223511111

14 [Total of skipistes I v [Genenl v

15 [Duration of descent [ v [ Geneal v

16 [Route Rating [ v '[ General v

17 " [Route Lengih [ @ coea &

18 [TotalLits '\ v '! General v

19 [Nearsst iy | ¥ [Genen v

20 [Totel Length of Pstes Flovaw | e v

21 [Type of Destination [ ~v | General v

22 [Alitude [ v | General &

23 [Images [ v | Genenl v http://upload.wikimedia.org
/wikipedia/el/thumb

All the Elements are now accessible for any possible modification as shown above.

- Project Name: The Name of the Project

Project name [extreme sports

- Description: The Description of the Project

Description The Description of the Project..

- Project Logo: The Logo of the Project and the Thumbnail Preview of the Logo

Project logo - ——
! = Mo file(s) uploaded

- ) , Upload
| Avatitnon... | Aev enhéxBrke apxeio. | Logo




[ Categary

- Title: The Title of the Project

- Special Column: The Special Column

Special Column

Primary key

Special Calumn ‘ | tz:itb:g:’:je

The user is enabled to set/ define the data of the specific column either as

Primary key

Latitude (Y)

Longitude (X)

Data Type: The user is enabled to set/define the data type of each column

]Data Type

General v

: Number
Date/Time
Hyperlink

. Image [from file]
Image [flicker)

- Image [url]

. YouTube Video
File

(The field can be a free data type or Number, Date/ Time, Hyperlink, Image (from file),
Image (flicker or other Internet Image Bank), Image (url), YouTube Video, File.

The Buttons at the Bottom of the Page, allows the user to:

SAVE > ‘Save’ the changes,

DELETE PROJECT > ‘Delete’ the entire Project

DELETE DATA> ‘Delete” all Data of the Project but keep the Template

BACK> the ‘Back’ Button to return to the Previous Menu.

Delete project Delete data




2. Import Data > New Project > From Scratch

Create a new Template defining all the relevant fields from the beginning means that
the user in capable of creating a Project from Scratch. In this case, the user selects the
option below.

@ Import Data =2 B2
=

_ - Data Import Wizard - Step 1
U Import data based on an existing template
U O Import data based on an existing template

This menu enables you to
upload data files into the
systern. Your data can
sutomnatically be uploaded
easily and carrectly

To upload data based on an existing templats you nesd to sslect the subject/praject fram the above list and
dlick on the option “Upload data”
To review or modify the templats of the project dlick on ths option "Edit template”

Create a new template for your input data

O  Create a new template based on an (& Create a new template defining all the
existing excel file relevant fields fron the beginning

Select this option if you have already created the Select this option in case you have not created the

relevant Excel file including the data you want to relevant Excel file

publish (It is less time consuming since the template
is automnatically created by the system enabling you
to perfectly adapt it to your needs)

The user “clicks” the Next Button and the following form opens:

Data Import Wizard - Step 2

Create a new project

Project Mame Il

Description

o C

The user fills in the following free text fields.
- Project Name: The Name of the Project
- Description: The Description of the Project

He/she ‘clicks’ the “‘Next” Button to move to the next Step.



Data Import Wizard - Step 3

Create a new project - fdrfa

The following tables enable you to modify the template of the uploaded data file. Here the X (latitude) and
(longitude) columns as well as the primary key (up to two fields) need to be defined to ensure the uniqueness
of the data.

Data will not be entered unless you define the X &Y columns.

Total number of columns:0

’Col.Nurnber [Title |Specia| Column  |Data Type

Add Calurnn Save Cancel

The Table enables the user to modify the Template.



